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You are in for a treat this month as we visit the only 
Microsoft store in the Twin Cities at the Mall of America. Our 
hosts will show us the products—PCs and more—that they 
carry and how you can try before you buy at the store, and 
the services they provide—a help desk and training 
services. Just across the hall from the Apple Store, Microsoft 
aims to provide the same kind of local resource. As a PC 
user, here's your chance to get those questions answered 
and find out what this store has in store for you. 

The store is located at 162 South Avenue in the Mall of 
America. The store is located on the first floor. There is 
parking on surface lots on the south side or in the ramp off 
of 24th Avenue South on the east side or off of Cedar 
Avenue South on the west side. Let's have a good showing 
to demonstrate our appreciation of Microsoft's hosting of this 
event. 

Reminder: December Meeting is on the 1st Tuesday!! 

http://www.tcpc.com
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Last Month’s Meeting: Online Auctions and Sales-Anne Simpson 
By Sharon Walbran, SQWalbran (at) yahoo.com 

We welcomed back Anne Simpson, who did a great job of enlightening us on the current state of 
websites like eBay and eCrater. She showed us her website and detailed some of her recent  sales 
successes. One of the items she has been purchasing at thrift shops or garage sales and re-selling 
at a good profit are paper patterns from McCall, Simplicity, Vogue, and so forth. There is a big trend 
among sewers to find these retro patterns and make outfits using modern fabrics. The key is to only 
buy and sell patterns that have never been cut. Generally, she has been buying the patterns for as 
little as a quarter and listing them for around ten dollars. Nice markup! 

She is still selling her cookbooks on eCrater and eBay and doing quite well, but she showed us 
the store of the leading cookbook seller, another person from Minnesota. This super seller achieves 
her results because she takes the time to list ALL the recipes in each cookbook on the listing. Then 
when people do a search for a particular recipe they may find in the results these cookbooks as well 
as the typical recipe links from the popular recipe sites. This same super seller has learned the hard 
way to rate each cookbook as "average" in quality even though the books may be in quite good 
shape. Buyers can often be picky and if you list an item as in "good" or "very good" or "like new" 
condition, the buyer may find the slightest flaw—a stain on a page, a folded corner—and return the 
item. Returns are not something you want to happen and you also do not want to get any negative 
feedback, so she has learned to downplay the condition of her books to preserve her good name. 

Anne really encouraged members to set up their own stores on eCrater, but to wait until you 
have at least 100 items to sell—otherwise you will run out of items and not look professional –and to 
read the help topics for how to set up a store and to get someone to make a purchase from you and 
write a review. She also suggested selecting a name for your store that falls at the beginning of the 
alphabet so that your store always ends up in the first group on the screen. 

Thanks, Anne, for sharing your knowledge and experience with our members.  Back to Page 1 

Many more people are turning to Twitter now that they realize using it is more than announcing your 
breakfast menu and where you shop for your socks. So, if you are thinking of joining in on this real-time, 
constantly changing, global communication, but are unfamiliar with some of the jargon, let me help get you 
started. 

When a person writes 140 characters or less in their message box on Twitter and  presses Send the 
message appears in their ―timeline‖ and in e timelines of all the people who have chosen to ―follow‖ that 
person. The message is called a tweet. You send tweets, get tweets, and read tweets. 

When referring to other people on Twitter, the terms ―tweeps‖ or ―peeps‖ are used. I have seen 
―Twitterers‖ but that has too many letters to be used much. (No one uses ―twits‖ which would be a negative 
term not linked to Twitter.) 

All of Twitter has been called the ―Twittersphere‖ but again, too many letters to refer to it In a tweet, unless 
it‘s in a short tweet. Tweets that you read and enjoy can be forwarded to people who follow you. Forwarded 
tweets are called Retweets. You can also flag a tweet you write with a hashtag which looks like a pound 
(weight) symbol. The #  symbol plus wordorwordswithnospaces is inserted in a tweet, usually at the end. It 
allows that tweet to be seen by everyone who searches for that subject; for example: #twitterhumor 

Hashtags have other purposes, too, but are not ever necessary to use in a tweet. 
I often get breaking news from subjects that ―trend‖ -- this is where a multitude of tweets are sent about 

the same time and the same subject. These tweets may or may not be marked with hashtags. Trending topics 

recently were Occupy Wall Street, RIP Steve Jobs, Chaz Bono. Back to Page 1  

Do you want to tweet? 
By Linda Gonse, Editor / Webmaster, Orange County PC Users’ Group, CA 
September 2011 issue, Nibbles & Bytes, www.orcopug.org, editor (at) orcopug.org 

file:///D:/My%20Documents/TCPC%20News/2011.11/www.orcopug.org


3  The Digital VIKING November 2011 

The Tip Corner 
By Bill Sheff, Novice SIG Coordinator, Lehigh Valley Computer Group, PA 
October 2011 issue, The LVCG Journal, www.lvcg.org, Nsheff (at) aol.com 

Rename Multiple Files at Once 
Did you ever have a bunch of files, folders or pictures with similar names like DSC_12234? They are so 

uninformative. So I used to open Picasa and do a batch rename... it worked. But here is a simpler way without 
opening up another program. Highlight all the files/folder in question. Right-click, choose Rename and call it 
something that best describes them. For example, Family Picnic. Quick as a flash they are renamed to a 
uniform more meaningful name. The only thing I don‘t like is that the sequential numbers are put in 
parenthesis while Picasa allows you to set the numbering convention. Either way you get rid of files called 
File1, File2, etc. 
 
Reformat a flash drive 

I think this is a tip that is not really needed, however there might be some of you who are wondering if you 
have the capability of reformatting a flash drive. Well you do, and here is a reason you might want to. Lots of 
flash drives are formatted in FAT32. Today we know that a more space saving method is the format NTFS. 
So to pump up the drive to save a few more files you would want to change to the NTFS format. Actually, a 
flash drive can be reformatted the same way as any other drive. 

As we know, when you plug in a flash drive your computer automatically assigns it a drive name and it 
looks like any other hard drive, so just go to ―Computer‖, right-click on the drive, and then click on ―format‖. 
You then have some options. File type should be NTFS (or FAT32 if available). You can then assign a name 
to the drive, and finally you can decide if you want full or quick format. The full format will take a lot of time 
and actually reformat the whole drive. The quick format just erases the File Index. It does not change any 
bytes on the drive, Then just click on ―Start‖. When done the ―format will say complete‖. 

Now, here are a couple of caveats you should be aware of. If the flash drive came with certain programs, 
such as security or maintenance programs you might want to copy them to your hard drive during the format 
and copy them back over after the format is finished. A format destroys all data (or at least hides it from 
normal viewing). 

Also, there is some thought that reformatting will reduce the life of your flash drive. Does it? By how 
much? Hard to quantify, and even harder to decide if that it actually does reduce the life of your drive. I really 
wouldn‘t worry about that. 
 
Storing important files 

While on the subject, which is better for storing an important file? Your computer hard drive? External 
drives? Or optical media such as CDs and DVDs? Where to store precious pictures or personal data is a 
serious question. How long will a disk or drive last? Will it fail? Will the medium become obsolete? (Anybody 
still remember floppy disks?) To answer this question, first we need to look at some of the qualities and 
limitations which the most commonly available storage formats present. 
 
Storage Format: Hard Disk Drives 
Pros: Large storage capacity for the price / Typically good lifespan. 
Cons: Susceptible to malfunction due to mechanical failures and physical impact. 
 

Inside your computer (desktop or laptop) is probably the safest place to store your hard drive(s), but doing 
so will not guarantee a trouble free experience. Why? There are just too many moving parts. 

Inside the hard drive case are discs which spin as a mechanical arm which moves back and forth above 
the disc surface, reading and writing data to and from the platters beneath. While this method of data storage 
has worked for many, many years, there has always been one unavoidable fault which leads to inevitable 
failure of a hard drive...the aforementioned mechanical parts. As with any device which relies on constant and 
precise mechanical movement to run, hard drive parts eventually fail, usually taking your data to the grave 
with them. Due to the precision with which they operate, hard impacts may also cause a hard drive to read or 
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write data in error, and possibly fail altogether as well. Despite these shortcomings, most hard drives have a 
life expectancy of at least 3-5 years, with many reportedly living a healthy life at 10+ years of age. 
 
Storage Format: Optical Media (CD-R / DVD-R) 
Pros: Inexpensive, portable 
Cons: Inconsistent lifespan, temperamental storage requirements, data lost over time due to degradation 
 

Optical media are quite handy for short term storage of data. However, they remain a less than desirable 
choice for long term and mission critical data archival. The reason is simple: everyday optical media degrades 
quickly and easily. Although many manufacturers claim their optical media will last for 30 years or more under 
perfect conditions, their actual lifespan with normal use and storage is typically closer to a few years (at most) 
than a few decades. There are many different factors which conspire against the lifespan of CD-R‘s and DVD-
R‘s; sub-par dyes (the reflective portion of a disc where data is written) which degrade much sooner than 
rated, exposure to heat, cold, or sunlight which also degrade said dyes, and weak or wrongly calibrated 
optical disc burners which fail to write data as intended. All of these factors make every day optical media 
formats a less than favorable storage choice; ok for short term data storage, but definitely not the choice for 
long term backup of important information. 
 
Storage Format: Flash Drives 
Pros: Durability, Versatility 
Cons: Debatable life span, higher price per gigabyte 
 

The last decade has given rise to the newest consumer storage devices in this comparison: solid state 
flash (aka thumb) drives. Unlike the aforementioned storage mediums, flash drives use no moving parts or 
temperate dyes to store data, relying instead on electrical pulses to write data to a static storage chip. This 
method of storage allows for much higher shock resistance and durability, as well as smaller form factors and 
increased portability, than what is traditionally offered in a hard drive or CD/DVD. 

The downside to this fantastic usability is a generally higher price per mega/gigabyte (i.e. for the price of a 
32GB flash drive, you could purchase a larger portable hard drive with a terabyte (1000 gigabytes) of 
storage.) The life expectancy of flash drives is also up for debate, as the solid state memory used to store 
your data does wear out the more times you write to it. Good quality flash drives from well known, trusted 
manufacturers are typically agreed to have a life span of a few years or more, making the flash drive a good 
choice for your everyday data storage needs. 

By now you‘re probably thinking to yourself ―should I use any of these formats to store my data?‖ The 
answer is yes: use all of them. If you want to sleep soundly at night without worrying about your irreplaceable 
pictures, videos, documents, etc., regularly backup your important data on at least two sources; creating 
duplicates which will allow you to retrieve your important information should any one backup fail completely. 
And keep in mind, as newer methods arrive, such as BluRay disks or bubble memory or cheaper solid state 
drives, the older methods such as CDs and DVDs start fading away. As I asked earlier, ―Remember the 
floppy drives?‖ I gave away hundreds of 5 ¼ floppies, and still have hundreds of 3 ½ drives. Anybody still 

have a drive to run them on?? Back to Page 1  
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Make Your Own Windows7 Theme 
Win7 offers many interesting visual themes to choose from, but if you'd prefer to look at personal photos 
instead, you can use them to create your own custom theme. To create a new theme, right-click an 
empty part of the Desktop and choose Personalize. Next, click Desktop Background and use the 
Browse button to find the folder containing the photos you want to use. (If you want your theme to 
include photos from different locations, copy them into a single folder in advance, because you can't 
select photos from multiple folders.) All the pictures in the folder you choose will be checked by default, 
so be sure to clear any that you don't want to include. Then adjust the picture position, select how often 
you want the picture to change, or select the shuffle settings as desired. Click the Save Changes 
button. You'll now see Unsaved Theme in the upper left corner under My Theme; Choose Save theme 
and give it a name. You can also change the sounds with the theme by choosing Sounds.  
Contributed by Linda Nelson 
 

Disable UAC on Windows 7 
Windows 7 makes it much easier to deal with UAC settings, and in fact you don‘t have to completely 
disable UAC if you don‘t want to. Just type UAC into the start menu or Control Panel search box. You 
can simply drag the slider up or down, depending on how often you want to be alerted. If you drag it all 
the way down to the bottom, you‘ll have disabled it entirely. Go to http://tinyurl.com/2ehc5m to read the 
illustrated article.  
Contributed by Sallie Northrop 
 

Many Users Do Not Know What a Web Browser Actually Is 
To a non-computer person, the browser is "internet". For a good swath of people out there, if you said, 
"Launch your web browser", they‘d have absolutely no clue what you‘re talking about. But if you said: 
"Start your internet", that magically makes sense to them, even though it literally makes no sense at all. 
Culled from a PCMech ezine articles 

 

10 Great Windows 7 Keyboard Shortcuts 
1. Ctrl + Shift + Click – Open a Program as Administrator 
2. Shift + Right-Click on a Folder for a Command Prompt 
3. Windows-button + Number – Select Taskbar items 
4. Ctrl + Shift + N – Create a New Folder in Explorer 
5. Shift + Right-Click – Extends the Send-To Menu 
6. Ctrl + Shift + Escape – Open Task Manager 
7. Windows-button + Pause – Open System Properties 
8. Windows-button+B to Focus on System Tray 
9. Shift+Click on Taskbar Item to Open Second Instance 
10. Windows-button+Space to Show the Desktop 
http://maketecheasier.com/10-great-windows-7-keyboard-shortcuts/2011/10/01 
 

Web Site Recommendation 
Everything you ever wanted to know about Hennepin County but didn‘t know where to ask:  
http://www.hennepin.us/ 



November 2011 The Digital VIKING 6  

IE9 Hint 
If you want a little more room for your open IE 9 tabs, simply right-click in the area your tabs normally 
open in and put a check next to Show tabs on a separate row. 
 

Windows Explorer 7 Hint 
To see the remaining drive space click Change Your View button (located off to the upper-right side of 
the Windows Explorer window) and make sure it is set on Tiles. 
 

Autoruns 
Autoruns is one of the Sysinternals utilities developed by Mark Russinovich and Bryce Cogswell. 
Somebody at Microsoft must have admired their work, because Microsoft bought the company last year 
and now touts these utilities from its own web site. To find out what programs are loading on your PC at 
startup, you can run the Windows-resident system configuration utility called MSCONFIG. But there's 
another free utility called Autoruns that does the job better. MSCONFIG entries tend to be rather cryptic, 
for example, but Autoruns includes a line of description for each entry in plain English. Autoruns also 
lets you Hide Signed Microsoft Entries, which allows you to quickly narrow your focus to third-party 
programs. Disabling or deleting entries requires just one click (so you'll need to be careful!). This 
function really saved my sanity when my system was breached by a scrap of regenerative malware. 
(Quoted from PCWorld Reviewed) 
http://www.pcworld.com/downloads/file/fid,64989-order,1-page,1/description.html 
 

New Technology 
Near Field Communication (NFC) for wirelessly transferring data. It is not Wi-Fi, Bluetooth, or IrDA. 
NFC differs from those methods in a couple of important ways. First, the devices must be very close to 
one another (within a few inches) to exchange information. In addition, the data is protected by strong 
encryption, so that you can send sensitive data such as credit card information securely. Augmented 
Reality (AR): The idea behind AR is to combine a live view of an object or environment with real-time 
data generated by a computing device. Here‘s an example: You point your phone at an office building, 
and the information overlay tells you the name of the building, who owns it, company or companies 
occupying it, its current property tax valuation, maybe even whether companies in the building are 
hiring. 
Excerpted from a TechRepublic blog 
 

Windows 7 Disc Image Burner 
This is more of a bonus than a hidden tool, but it can still be pretty useful. If you have ISO files you 
need to burn, and you don‘t happen to have any other burning software installed, To open the Disc 
Image Burner type ‗backup‘ in the search bar. Click on ―Backup and Restore‖, then on ―Create a 
System Image‖. 
http://windowssecrets.com/top-story/build-a-complete-windows-7-safety-net/ 
 

Windows 7 Malicious Software Removal Tool 
This is a good tool to use in addition to other anti-virus programs. If your regular program doesn‘t detect 
something, or if you happen to have nothing else installed, Windows provides its own malicious 
software removal tool. Type ―mrt‖ in Windows search to find it. You can choose between a quick scan, a 
full scan and a customized scan, and MRT will scan your computer and give you a report on its findings. 
The tool only scans for a somewhat limited list of malicious software, so it cannot replace an anti-virus, 
but you can use it for extra security, and it also provides links to further reading on each malware on the 
list.  
http://support.microsoft.com/kb/890830 
 

Back to Page 1 
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Bluetooth - Not a dental diagnosis or a rare tooth problem. 
By Phil Sorrentino, President, Sarasota PCUG, Florida, October 2011 issue, Sarasota PC Monitor, 
www.spcug.org, president (at) spcug.org 

Bluetooth is the name given to a technology that uses short-range radio links, and is intended to 
replace the cable(s) connecting portable and/or fixed electronic devices. The vision is that it will 
allow for the replacement of the many propriety cables that connect one device to another with one 
universal radio link. Its boasts such key features as robustness, low complexity, low power and low 
cost, and it was designed to be operated in noisy frequency environments. 

Bluetooth is a communications standard for interconnecting electronic devices and is defined by 
the Bluetooth specification.  Bluetooth uses a form of data packet switching, a technology that is 
used to transmit digital data via a wireless communications link.  Bluetooth operates in the 
unlicensed ISM (Industrial, Scientific and Medical) 2.4GHz frequency band, and avoids interference 
from other signals by hopping to a new frequency after transmitting or receiving each packet.  Here 
is a little history, for you tech history buffs, to show how long Bluetooth has been around.  Work on 
Bluetooth was started in 1994 by two Ericsson Corporation engineers, and the Bluetooth 1.0 
specification was released May 1998. Version 1.0, with a data rate less than 1 Mb/s, had many 
problems, and manufacturers had difficulty making their products interoperable.  Bluetooth 2.0 was 
released November 2004 with a faster data transfer rate (approx. 2.1Mb/s).  And finally, Bluetooth 
3.0 was released April 2009 with a date rate of up to 24Mb/s with improvements and new features 
and is the current standard. 

Bluetooth uses a radio technology called frequency-hopping spread spectrum which chops up 
the data being sent and transmits chunks of it on up to 79 different frequencies. Bluetooth provides a 
way to connect and exchange information between devices such as Smartphones, laptops, personal 
computers, printers, Global Positioning System (GPS) receivers, digital cameras, video games, and 
others.  

Bluetooth is an open, wireless protocol for exchanging data over short distances between 
devices, creating a personal area network (PAN).  It was originally conceived as a wireless 
alternative to the old serial RS-232 data cables. Bluetooth is a network and thus can connect many 
devices, unlike RS-232 which was strictly serial point-to-point.  Bluetooth is primarily designed for 
low power consumption, with a short range.  Three ranges are defined in the standard, 100 meters 
(Class 1), 10 meters (Class 2), and 1 meter (Class 3).  Because Bluetooth devices use radio 
(broadcast) communications, they do not have to be in line of sight of each other.  Bluetooth makes 
it possible for these devices to communicate with each other and transfer information as long as 
they are in range.  

Both Bluetooth and Wi-Fi are examples of wireless technology that use the unlicensed 2.4GHz 
frequency spectrum.  Both have many applications in today's offices and homes such as: setting up 
networks, printing, connecting cooperating devices, and transferring data files among computers and 
smart devices. Wi-Fi is intended as a replacement for cabling for general local area network access 
in work areas.  Bluetooth is intended as a replacement for cabling among equipment in close 
proximity.  Wi-Fi is intended for use in equipment as a wireless local area network (WLAN).  
Bluetooth is intended for use as a smaller, personal area network (PAN). 

A PC uses a Bluetooth adapter in order to communicate with other Bluetooth devices.  While 
some desktop computers and most recent laptops come with a built-in Bluetooth adapter, others 
require an external adapter, usually in the form of a Bluetooth Dongle.  Bluetooth allows multiple 
devices to communicate with a computer over a single adapter.  For Microsoft Windows platforms, 
Windows XP Service Pack 2, Vista, and Windows 7 all have native support for Bluetooth. (Previous 

file:///D:/My%20Documents/TCPC%20News/2011.11/www.spcug.org
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versions required users to install their Bluetooth adapter's own drivers, which were not directly 
supported by Microsoft.) 

Some of the more common applications of Bluetooth are: 
 Wireless control of and communications between a mobile phone and a hands-free 

headset.  This was one of the earliest applications. 
 Wireless communications with PC input and Output devices, the most common being 

the mouse, keyboard and printer. 
 Replacement of traditional wired serial communications used in: test equipment, GPS 

receivers, Medical equipment, bar code scanners, and traffic control devices. 
 Between game consoles such as Nintendo‘s Wii, and Sony‘s Playstation and their 

respective controllers. 
 Between video camera and remote monitor in Baby Monitor Systems. 
 Between Garage Door Opener Motor and Remote Garage Door Opener Controller. 

As you can see from this list, there are many reasons for computer devices to communicate with 
each other.  Here is a quick computer communications concept tutorial.  When any two devices 
need to communicate, they have to agree on a number of things before the communication can 
begin. The first point of agreement is physical: Will they talk over wires, or through some form of 
wireless signals? If they use wires, how many are required; one, two, eight, 25? Once the physical 
attributes are decided, additional questions arise, such as how much data will be sent at a time? For 
instance, serial ports send data 1 bit at a time, while parallel ports send several bits at once.   And, 
how will they speak to each other? All of the devices in an electronic network need to know what the 
bits mean and whether the message they receive is the same message that was sent (i.e. 
checksums at the end of a message).  

This means developing a set of commands and responses commonly known as a Protocol. 
Bluetooth is essentially a networking standard that defines these two levels, physical and protocol. 
Bluetooth protocols simplify the discovery and setup of services between devices.  Before any 
communications can take place between two Bluetooth devices, they have to be paired.  In order to 
pair two Bluetooth wireless devices, a password (or PassKey) has to be exchanged between the two 
devices. A Passkey is a code shared by both Bluetooth devices, which proves that both users have 
agreed to pair with each other. 

A very brief description of Bluetooth pairing is as follows:  Bluetooth Device A looks for other 
Bluetooth devices in the area.  Bluetooth Device A finds Bluetooth Device B.  Bluetooth Device A 
prompts you, the user, to enter a password (or PassKey).  Bluetooth Device A sends the Passkey to 
Bluetooth Device B.  Bluetooth Device B sends the Passkey back to Bluetooth Device A.  At this 
point, Bluetooth Devices A and B are paired and able to exchange data.  Data between the devices 
will be accomplished wirelessly, over-the-air, a great boon to those who dislike the ―rats nest‖ of 
wires typically found behind electronic devices. 

So, although dentists probably cringe when they hear the term, with all the computer devices you 
may have or are thinking of getting, there‘s probably a Bluetooth in your future. Back to Page 1  
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Create a Building Block in Word 2007 or 2010 
By Nancy DeMarte, Columnist, Office Talk, Sarasota PCUG, Inc., FL  
October 2011 issue, Sarasota PC Monitor, www.spcug.org, ndemarte (at) Verizon.net 

If you create many documents in Word, you may find that you often include portions of text with 
similar content or format. For example, when preparing to submit SPCUG classes each month to the 
Monitor, I always include a list of the details: dates, day, time, location, instructor, and instructor‘s 
email address. As I learned more about Word 2007, I realized I could set up a skeleton format for 
these class postings and save it as a ―building block‖ (aka Quick Part) in Word. When I needed to 
prepare a new class posting, all I had to do was insert this building block into a document after the 
class description and enter the specific details, saving me the hassle of recreating the format. 

New in Word 2007, building blocks are related to templates except they are bits of text, rather 
than a whole document. For user convenience, a complete set of pre-formatted building blocks is 
listed on the Insert tab in the Text group under ―Quick Parts.‖ Click the Building Block organizer to 
find pre-formatted text boxes, headers and footers, cover pages, page numbers, and more. Many of 
these building block galleries are also available under their own icons throughout Word. The Building 
Block organizer, however, includes all the categories in one place. You can insert any one of these 
blocks into a document or template by opening the document, placing the cursor where the block 
belongs, clicking the Insert tab, then Quick Parts, Building Block organizer, and the building block 
you want.  If that sequence seems too cumbersome, you can add the Building block organizer to the 
Quick Access menu. Right click the organizer title and select ―Add to Quick Access toolbar.‖ 

Creating your own building blocks is easy and can save you lots of repetitive typing. The first 
step is to create a piece of formatted content. Let‘s use the example of a logo which could be used 
in a letterhead, business card, and other documents. 
Since building blocks may contain many types of content, 
such as lines, images, drawings, and tables, as well as 
text, I created one using a table with text and a piece of 
clip art from the Word program. Here‘s how it looks: 

My next step was saving the building block. I 
selected the logo, clicked the Insert tab, then Quick Parts, 
and chose ―Save selection to Quick Parts gallery.‖ This 
action opened the ―Create New Building Block‖ dialog box, where I gave my block a Name, OTS 
logo. In the Gallery area, I left it labeled ‗Quick Parts‘ because it didn‘t fit into any of the existing 
galleries.  Under Category, I created a new one called Nancy, which let me group all my custom 
building blocks together for easier access. I skipped Description, although if I had I added one, it 
would have become the Screen Tip for the block. I left the Save In and Options boxes as they were 
and clicked OK to save my changes. 

Now it was time to try adding my new building block to a document. I opened a blank 
document and double-clicked about half way down the page to position the cursor there. Then I 
clicked the Quick Parts icon on the Insert tab, which showed previews of my last three custom 
building blocks. I clicked OTS logo and it appeared in the document where my cursor had been. Had 
the block not been visible as a preview, I would have clicked Building Block organizer and scrolled to 
Quick Parts under the Gallery column to locate it. 

Next I decided to change the font in the logo heading. I knew that any building block can be 
modified in a document without changing the version stored in the Building Block organizer. I 
changed the font of OTS from Goudy Stout to Bodoni MT black.  As an experiment, I saved the 
modified version to the Quick Parts gallery with the same name and properties as the first version to 
see if it would overwrite the original. I was surprised to find that it did not. I ended up with two 
different versions with the same name. I decided it is necessary either to delete a first version before 
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saving a second or give the second version a different name. Finally, since the logo block was only 
for illustration purposes, I decided to delete it. I simply opened the Building Block organizer, scrolled 
to and selected OTS logo, and clicked Delete. 

My own collection of custom building blocks includes a footer which includes my name, page 
number and current date; a copyright sign with my name; the SPCUG class detail list; and a 
personal logo I use as a letterhead. I do, however, often select from the galleries of pre-formatted 
building blocks located on almost every tab of Word 2007; for example, watermarks on the Page 
Layout tab, cover pages and text boxes on the Insert tab, or Table of Contents and Bibliographies on 
the References tab. More building blocks are available at www.office.microsoft.com. 

The more I customize my Word 2007 program, the easier tasks become. Creating custom 
Building Blocks is one more way to make Word 2007/10 my own.  Back to Page 1  

Introduction 
For Windows 7, Microsoft has stopped furnishing the Windows Photo Gallery that was built into 

Windows Vista, and instead made a version of the program available from the Windows Live site. 
Windows Live Photo Gallery can also be installed in Windows Vista and Windows XP. By removing 
this component from the operating system, it is to be hoped that Microsoft will be able to provide 
updates and improvements in a much more timely manner. 
 
Download 

You can download the latest version of Windows Live Photo Gallery from here: 
http://www.windowslive.com/Desktop/PhotoGallery 
 
About Windows Live Photo Gallery  

With Windows Live Photo Gallery, you can manage all your photos, search for them,  import 
them from a camera or other removable media, order prints online, and publish them (upload to 
Windows Live Spaces, Flickr). 

When you import photos, they are automatically grouped by date and time. You can edit them to 
fix redeye, crop out unwanted sections, correct colors, and adjust the lighting, sharpness, etc. Any 
edit you make to your photos can be reverted later at any time. 

You can stitch several photos together to offer a "panoramic" view. You can also apply a 
treatment to color photos to convert them to black and white and shades of grey. 

The list of capabilities of the program goes on and on. 
 For example, you can send photos by e-mail, burn them to a CD, and print them. 
 You can add tags, ratings, and captions. Since Live Photo Gallery has the ability to automatically 

recognize faces, you can tag them with the names of the people in the photos and therefore be 
able to search by the people in your photos. 

 You can resize, rotate, delete and rename the photos. 
 There is QuickTime movie support if you have QuickTime 7 or later installed.Back to Page 1  

The Seventh Son of Windows-Windows Live Photo Gallery  
by Lee Reynolds, Member, Boca Raton Computer Society, FL, October 2011 issue, Boca Bits, 
www.brcs.org, leetutor (at) exploringwindows.com 
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Where Did My Restore Points Go in Windows 7? 
By Sharon Walbran, TC/PC User’s Group, Twin Cities, MN, www.tcpc.com,  
Editor, TC/PC Digital Viking, SQWalbran (at) yahoo.com 

I am a huge fan of Restore Points in 
Windows. I can‘t count how many times 
restoring a computer to an earlier date has 
saved me and many of my clients from 
disaster. 

Recently I was installing some small 
software programs that I was somewhat 
dubious about. I went to set a Restore 
Point in Windows7 and the command was 
not where I expected it to be. Going to 
Start, All Programs, Accessories, 
System Tools, System Restore only got 
me to the Restore mode, not the Set 
Restore Point mode. After a little digging, I 
learned I had to go to Start, then right-
click on Computer, click Properties, then 
click the System Protection category in 
the left panel and on the System 
Protection tab, click the Create button. 
Whoops! The Create button was grayed 
out. I went back to the System Restore 
settings in System Tools where I had 
originally gone and there was only one 
Restore Point listed, a Windows Update 
from that morning, when I knew I should 
have had several more because of other 
Windows Updates and other software 
restore points I had set. 

Time for Google. I learned that the main reason System Restore would be turned off by Windows 
is if there is not enough free disk space on the C: drive or the drive you are setting a Restore Point 
for. Windows7 needs at least 15 percent of the hard drive free to create a Restore Point. 

I checked the hard drive. Sure enough. I had been working on some movies for a client earlier in 
the month and had so many versions of the movies built up on my computer that my hard drive was 
down to a little less than10 percent free disk space. I moved the movies to an external hard drive 
and deleted several and freed up 25 percent free disk space. (They were huge files.) 

Back to the System Protection settings. The Create button was now available – Whew! - and all 
the drives were listed. That list had been limited to the C: drive before. I also headed back to the list 
of Restore Points. Still just one listed. Hmmm. Fortunately, there is a checkbox with the label: Show 
more restore points. I checked it and – Woo hoo! – a list of 7 Restore Points displayed. 

So the moral of the story is to be sure to set Restore Points, whether manually as I did or if 
prompted by your anti-virus program, before installing any software. And keep an eye on how much 
free space you have available. Windows needs that free disk space for storing Restore Points but 
also for general disk swapping when RAM is full.  Back to Page 1  
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